
Installation Guide
Autodesk Showcase 2009

March 2008 Release



2 AUTODESK SHOWCASE 2009 INSTALLATION GUIDE



AUTODESK SHOWCASE 2009 INSTALLATION GUIDE

Table of Contents
About this release 5

What’s new this release 5

Release notes 5
Opening and importing files 5
Graphics card notes 6
Other notes 7

Installing 9

System requirements 9
Hardware requirements 9
Graphics hardware requirements 10
Operating system requirements 10
Other requirements 10
Security notice 10

Install Autodesk Showcase 11
Install Autodesk Showcase 11
More on custom installation 15

Uninstall Autodesk Showcase 16

Licensing 17

Introduction 17
What licensing does... 17
When you need a license 17
Some definitions 18

Activate the software from a serial number 19
What is a serial number? 19
What are hardware IDs? 20
How does activation work? 20
Activate your software from a serial number 21
Next steps (if the licensing is successful) 23
If the licensing is not successful 23

Activate the software from a license 23
Activate the software from a license 24
Next steps (if the licensing is successful) 25
If the licensing is not successful 25

Set up a floating license 25



4 AUTODESK SHOWCASE 2009 INSTALLATION GUIDE

Floating license setup overview 26
Acquire the floating server license 26
Install the license server (Windows) 27
Set up the license server (Windows) 27
Set up the license server (other platforms) 29
Set up the client computers 29

Troubleshooting 31

Licensing problems 31
Check the installation log 31
You may not have the right permissions 31
If you need to launch the Product Configuration Wizard later 31

Contacting the Autodesk Showcase support team 32
Pre-contact checklist 32
Pre-contact preparations 32
Contacting Autodesk Showcase support 33

Legal notices 35

GNU Library General Public License, Version 2 36

wxWindows Library License, Version 3 41

The Python Imaging Library (PIL) 42

The OpenEXR Library v.1.2.2 43



AUTODESK SHOWCASE 2009 INSTALLATION GUIDE 5

About this release

What’s new this release
This Autodesk® Showcase™ 2009 release (March 2008) provides a number of 
enhancements. For details on what’s new and on how to use the new features, see the 
online help.

Release notes

Opening and importing files

Re-imported wire files lose material assignments, transformations

On rare occasions, a StudioTools wire file may produce inconsistent results when it is re-
imported into Showcase. For example, there may be lost transformations, wrong material 
assignments, or duplicated objects. 

Workaround: Group all objects in StudioTools under a single node before saving the file 
and first importing it into Showcase.

Problems re-importing duplicated geometry

If you duplicate geometry in Autodesk Showcase and then try to replace the model 
containing that geometry, the software may try to load geometry it can’t find. 

You can continue to use the software, but it may perform more slowly as it continues to 
search for the missing geometry. 

Workaround: If you duplicate geometry in the software and then need to replace it from 
the Import Status window, first use the Organizer to delete the duplicate 
geometry.

Special characters not supported in file names

If file names contain special characters (such as umlauts or accents), the files will not load 
in many situations. 

Workaround: Avoid using special characters in file names for scenes, models, or 
texture images.
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File open and import failures while running multiple releases of Showcase 

If you cannot open files or import geometry, there may be a version conflict of Autodesk 
DirectConnect introduced by launching and running an earlier version of Showcase at the 
same time.

Workaround: Exit all other releases and versions of Showcase before starting another 
version or release on the same system.

Some imported materials cannot be added to alternatives

If a material on an imported object has not been replaced or edited in Showcase, adding 
the material to an alternative does not work. 

Workaround: Select the object with the imported material and then create the 
alternative.

Graphics card notes

Graphics card must be qualified

If you experience problems with viewing a scene (no shadows, materials appearing flat or 
black), your graphics card may not be qualified. Check the System requirements for a list 
of supported graphics cards.

Display becomes too bright and peformance is reduced due FSAA and 
HWAA conflict 

If the display becomes too bright after loading a scene or performance is greatly reduced 
in all scenes, the graphics card may be unable to anti-alias the scene with both full-screen 
anti-aliasing (FSAA) and hardware anti-aliasing (HWAA) at the same time.

Workaround: Turn down or disable hardware anti-aliasing (HWAA) in the graphics 
driver. For NVIDIA control panels, this is under “Adjust image settings 
with preview” set to Use My Preference Emphasizing: Performance.

Disable SLI for hosted sessions

When using the Hosted Session feature with the QuadroPlex graphics hardware, disable 
SLI to ensure good performance.

Full screen mode does not work after graphic card settings changed 

If you change graphic card settings while running an Autodesk Showcase session, the full 
screen mode will appear broken.

Workaround: Close the Autodesk Showcase session and start it again. 



ABOUT THIS RELEASE

7AUTODESK SHOWCASE 2009 INSTALLATION GUIDE

Increased antialiasing may reduce performance or create visual artifacts

If you increase the antialiasing in the scene, you may experience reduced performance, 
ghosting or other visual artifacts while the anti-aliasing is being performed. These effects 
will depending on your graphics processor and the complexity of the scene.

Workaround: If you encounter these conditions, reduce or disable antialiasing. (Select 
Options > Performance and Quality.)

Other notes

Showcase 2008 R3 prevents CIP from functioning 

There is a limitation with the previous Autodesk Showcase 2008 R3 software release that 
prevents the Autodesk Customer Improvement Program (CIP) from functioning properly. 
The limitation prevents information from being sent by CIP from systems with Showcase 
2008 R3 installed. This limitation has no impact on the operation of Showcase. 

Workaround: Remove the following file:  
C:\Program Files\Autodesk\Showcase2008\bin\UPI\upiconfig.xml 

The removal of this file has no impact on how Showcase or Windows 
functions

Must type “.zip” explicitly to save zip files 

If you choose to save a scene as a compressed archive (zip) file, you must explicitly type 
a .zip extension in the file name.

Cannot revert to previous ambient shadow settings

If you calculate ambient shadows at one resolution and then calculate them again at 
another resolution, you cannot use Undo to revert back to the re-calculation. 

Workaround: To use the previously saved settings, close the file without saving it.
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Installing
This section describes system requirements for the Autodesk® Showcase™ software, and 
how to install it.

• “System requirements” on page 9

• “Install Autodesk Showcase” on page 11

• “Uninstall Autodesk Showcase” on page 16

System requirements

Hardware requirements
• CPU: Intel® Pentium® 4, Pentium Xeon®, 3.0 GHz or better or Athlon® 64 or 

AMD® Opteron® 2.0 GHz or better. Multi processor machines are fully supported 
by Autodesk Showcase and are recommended for best performance.

• Storage: 20 GB free hard disk space minimum for program files and data 
preparation and scene storage space. Storage requirements depend on the 
complexity of projects. 20 GB should be considered a minimum requirement.

• Memory: 2 GB for 32-bit (see note below); up to 4 GB for 64-bit.

Note For 32-bit Windows XP, the normal application memory partition is 2 GB for the 
system and 2 GB for applications. This means that the largest virtual memory an 
application (including Autodesk Showcase) can obtain is 2 GB.

Under 32-bit Windows XP SP2, the /3GB system boot option is available to 
partition the memory into 1 GB for the system and 3 GB for the application. Using 
this boot option will enable Autodesk Showcase to recognize an additional 1 GB 
of virtual memory, up to 3GB.

Note Autodesk Showcase is multi-threaded and will take full advantage of multiple 
processors or multi-core CPU configurations. Autodesk Showcase can also be 

These system requirements are subject to change. For the latest qualification charts, 
go to www.autodesk.com/qual-charts.
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used on SLI configured workstations (using multiple SLI-enabled graphics 
processors).

Graphics hardware requirements
• Minimum graphics hardware required is an NVIDIA® GeForce™ 8800 GTS 

(640MB), NVIDIA® Quadro™ FX4000, 4400, 4500, 4600, 5500, 5600 or better is 
recommended.

• Minimum graphics memory required is 256MB. 512MB or more is strongly 
recommended.

• NVIDIA driver version 163.75 is the minimum driver version required. When 
installing or upgrading Autodesk Showcase, it is recommended that you install the 
most recently released graphics driver available from www.nvidia.com/drivers.

• ATI graphics cards are currently not supported.

Operating system requirements
• Windows® XP Professional with Service Pack 2 or higher

• Autodesk Showcase is not supported on Windows XP x64 (64 bit edition).

Other requirements
• You cannot install this software or import CAD files while running it unless you 

have a "Power User" or Administrator account. If you are using a restricted “User” 
account, you can run the software and open existing Showcase scenes, but 
cannot import files.

• The following folder must be writable on your system: 
C:\Documents and Settings\<yourname>\My Documents

• The custom Flash® user interface available for Autodesk Showcase software 
requires Flash Player Version 8, available from www.macromedia.com/go/
getflashplayer.

• Internet Explorer 5 or higher (installed as a default component with Windows XP).

• An Internet connection is recommended for product activation.

• A high-speed network is required for hosting Autodesk Showcase sessions, 
unless data is first copied to client machines. 

• For games-like navigation and control, the Logitech® Cordless Rumblepad™ 2 
gamespad is supported.

Security notice
Note that use of this product may jeopardize the data on your system without the proper 
safeguards in place:

• Set up an online session with trusted participants only.

• This product requires a full copy of Internet Explorer running. Verify that your 
system administrator is aware of any current Internet security issues, and that 
your system has the latest virus checking software installed.

http://www.nvidia.com/drivers
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Install Autodesk Showcase

Install Autodesk Showcase

1. Uninstall any Autodesk Showcase software that was previously installed. (From the Start 
menu, select Settings > Control Panel > Add/Remove Programs.)

You don’t need to uninstall Autodesk DirectConnect. The Autodesk Showcase software 
will automatically install the latest version of Autodesk DirectConnect if it detects an out-
of-date version.

2. Insert the software disk in your CD-ROM drive, or double-click the file that you 
downloaded.

3. If the CD does not Autostart, browse the filesystem and click on the executable 
setup.exe.

After a few seconds, the Installation start screen appears.

Important Notes:
• You need to install this software in a "Power User" or Administrator account as 

opposed to a restricted “User” account.

• Before installing or uninstalling, close all running programs.

• When installing or uninstalling, do not cancel the installation or uninstall of 
Autodesk Showcase. Aborting an uninstall may, in rare circumstances, cause 
damage to the database of installed software in the Windows System Registry. If 
you find that you are unable to remove Autodesk Showcase using Add/Remove 
Programs in the Windows Control Panel, contact the Autodesk Showcase sup-
port team at www.autodesk.com/showcase-support for assistance.
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4. Select the Install Showcase option.

Note If you are installing the unlicensed Showcase Viewer, the installation procedure 
will be the same as below.

After a few seconds, the Product Configuration wizard appears.

5. Scroll through the software license agreement. After you read and understand the 
agreement, click I agree to the terms and conditions and then click Next.

6. After some time, the product configuration window asks you to continue. Click Next.

7. You are asked to select a setup type. It is recommended you select Complete for the full 
setup.

If you opt for a custom setup, see “More on custom installation” on page 15.
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8. Click Next. 

The File Type Association window appears. 

Any files of the formats checked in this window will be opened by Autodesk Showcase by 
default the next time you log on to your system. 

9. Click Next. 

The installation process is ready to start.

10. Click Install.

The installation process begins. It may take several minutes. 

11. The InstallShield Wizard indicates when the installation is completed. At that time, click 
Finish.

12. In the Product Configuration window, green check marks appear beside each installed 
component. 
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If you notice that some of the components were not installed, contact the Autodesk 
Showcase Support team for assistance.

13. Click Done.

Autodesk Showcase and Autodesk DirectConnect are now installed.

If you are finished with installations, select Exit the installer from the Installation start 
screen.

14. You will next need to license the software. Go to “Licensing” on page 17.
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More on custom installation

If you request a custom installation in the InstallShield Wizard, the following window 
appears:

Autodesk Showcase is installed in the folder C:\Program Files\Autodesk. To 
change this location, click the Change button.

It is recommended that you install all of the software features, but if hard drive space is an 
issue, you can reduce the hard drive requirements by removing any or all of the following 
components:

• Program files (deselect this if you are installing a floating license server that won’t 
be running the software)

• Help files.

• Examples, including:

• Preset environments, providing environments in which to view your 
models.

• Tessellation settings, providing scripts to convert model files to your own 
specifications

• Preset material library, providing a set of materials for decorating your 
models

• Flash Custom UI example, providing a sample Flash custom user 
interface.

• Plug-ins, including the plug-in required by Autdoesk® Maya® software to import 
and export Autodesk Showcase APF files.

• Licensing utilities (for floating license setup)

Important Note:
Unless hard drive space is an issue, it is recommended that you do not attempt a 
custom installation.
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To see how much hard drive space is required for any one of these components, select 
the component. Its required drive space is displayed in the Feature Description part of 
the window.

To specify if a component is installed, where it is installed, and when it is installed, click on 
the icon beside the component for a list of install options.

Uninstall Autodesk Showcase
1. From the Start menu, select Settings > Control Panel > Add/Remove Programs.

2. Select the Autodesk Showcase entry and click Remove.

Do I uninstall Autodesk DirectConnect?
• If you do not have any other Alias or Autodesk software on your system, you can 

uninstall Autodesk DirectConnect.

• If you have other Alias or Autodesk software installed on your system that 
imports CAD files using Autodesk DirectConnect, leave it installed.
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Licensing

Introduction
What licensing does...
A license is a coded record of your software purchase required to run the software. The 
license resides in a license file on your machine. 

When you need a license
You must go through the process of obtaining and installing a license if:

• You are installing Autodesk Showcase for the first time.

• You are relocating Autodesk Showcase to a different computer.

If you are a new customer ...

If you are a new customer and you only have a serial number, go to: 

“Activate the software from a serial number” on page 19

This topic applies for both node-locked and floating licenses.

If you have a license ...

If you already have a license for your Alias software, go to:

“Activate the software from a license” on page 23

This topic applies for both node-locked and floating licenses.

To set up your floating license server ...

To set up a license server, go to: 

“Set up a floating license” on page 25
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Some definitions

Serial number

A record of what you purchased, required for obtaining a license through Online 
Product Activation. Here is a sample of what a serial number might look like:

VCF030-B-3322-0933-7182-1111-0000

If you did not receive a serial number when you purchased the software, contact 
your local Autodesk sales office or your reseller.

Hardware ID (Host ID)

An alphanumeric code that identifies the machine that is authorized to run the 
software, required for Online Product Activation. This number can be an ethernet 
ID (also known as a MAC Address).

Online Product Activation (OPA)

An automated activation process where you submit an online form with your serial 
number and hardware ID, and a license is automatically generated and sent back.

Product Configuration Wizard (PCW)

A tool that uses Online Product Activation to allow you to request and install your 
license easily.

Node-locked license

A license for a single computer. It lets you run Autodesk Showcase only on the 
computer where the license is installed.

Nodelocked licenses look similar to the following sample:

FEATURE AutodeskShowcase sgiawd 3.000 09-jan-2006 1\ 
uncounted 7CD390F11000 HOSTID=123456789012

Floating license

A license to be shared by various computers on a network. The Autodesk 
Showcase software is installed on many computers, each with a license file that 
accesses the floating licenses installed on a server. Floating licenses require 
client and server setup. Also called a site license. 

Floating licenses look similar to the following sample:

SERVER pc-server 123456789012 7111 
VENDOR sgiawd 
FEATURE AutodeskShowcasef sgiawd 2.000 10-nov-2005 1\ 
        FC29A6FBF000

License file

A file with encrypted data that enables Autodesk Showcase to run on your 
machine. A serial number is required to generate a license file. 
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Client

In floating license configurations, the machine that requests a license from the 
license server

Server

In floating license configurations, the machine that provides licenses as 
requested by users on client machines.

Activate the software from a serial 
number

What is a serial number?
A serial number is a record of what you purchased from Autodesk, required for obtaining a 
license through Online Product Activation (OPA).

New customers receive a serial number in one of the following ways:

• emailed or otherwise sent directly from the reseller where you obtained your copy 
of the software. 

• emailed directly from Autodesk. 

• on the outside of the CD holder within your software package (available from 
selected resellers).

If you did not receive a serial number, contact your local Autodesk sales office or your 
reseller to obtain one.

Use these instructions if:
You only have a serial number and ...

• You are a new customer installing Autodesk Showcase for the first time.

• You are relocating Autodesk Showcase to a different computer.

Do not use these instructions if:
• You already have a license. Go to “Activate the software from a license” on 

page 23.

• You are setting up a floating license server. Go to “Set up a floating license” on 
page 25.

What do serial numbers look like?
Here is a sample of what a serial number might look like:

VCF030-B-3322-0933-7182-1111-0000
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What are hardware IDs?
A hardware identifier is an alphanumeric code that identifies the machine that is 
authorized to run the software. It is required along with a serial number to generate license 
data.

How does activation work?
The easiest and fastest way to activate your software is to send your serial number and 
hardware ID to Autodesk via the Internet. This process is called Online Product Activation.

After you fill out an Internet form, you are provided with license data you can use to 
activate your software.

What if I’m using a notebook (laptop)?
If you are licensing your software to run on a laptop, OPA may detect two or more 
hardware IDs, usually indicating a peripheral device is attached to the machine. In the 
case of a notebook (laptop), the multiple hardware IDs may indicate the notebook is 
attached to a dock. 

To ensure you choose the correct hardware ID, disconnect all peripheral devices 
from the machine, including the dock attached to the notebook. 

It is not recommended to use a notebook for a floating license server because it may 
frequently be off the network.

What if my machine isn’t connected to the Internet?
If no computer in your organization has access to the Internet, proceed to use the 
Product Configuration Wizard as shown in the following pages. When you come to the 
panel where you need to choose the method for submitting your serial number and 
hardware identifier, request your license by phone or fax (rather than the internet). 

If you can access the Internet from some machine in your organization (but not the 
machine you’re licensing):

1. On the computer that is being licensed, follow the activation steps in the next topic, 
but request the phone, fax, or email option (rather than the Web option). You will be 
provided with all the data you need to license the computer (hardware ID, serial 
number, and so on). Record or print this data.

2. On another computer that is connected to the Internet, go to the following URL: 
www.autodesk.com/opa/

3. Enter the serial number, hardware ID, and other information you recorded for the 
computer you want to obtain a license for. Once the license is returned, install it on the 
computer you want to license.
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Activate your software from a serial number

1. Install Autodesk Showcase, if you haven’t already.

2. From the Start menu, choose Programs > Autodesk > Showcase 2009 > Showcase.

(Or, to activate the program directly, choose Start > Programs > Autodesk > Showcase 
2009 > Licensing.)

If there is no valid license, Showcase will launch as the limited Showcase Viewer. The 
name in the splashscreen will indicate this:

Note Showcase Viewer is for client sessions running large displays and for sharing 
presentation files for viewing only. For more information, see the online help. 

3. Click Install License.

The Product Configuration Wizard appears.

4. Choose I have a serial number that I need to activate and click Next. 

I’d prefer to request licenses by phone, fax, or email ...
To submit your request by e-mail, phone, or fax (rather then from the Internet), follow 
the licensing windows through to the panel, How would you like to submit your 
request?

In this panel, click on Show all ways of making an activation request and follow the 
instructions to provide the information Autodesk needs to process your license request. 

Note that these alternative activation methods will take several days or longer to be 
processed.
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(If you don’t see this choice, click the [+] symbol next to Licensing Tasks to expand the 
choices.) 

5. Continue to follow the instructions in the Product Configuration windows to activate your 
software. You are prompted to: 

• Type in or paste your serial number

• Select your hardware identifier

• Submit your serial number and hardware ID to Autodesk (using the Web is 
recommended)

• Choose your preferred web browser

• Fill out a form on the Autodesk Product Activation web site with requested 
information. It then provides you with the license.

• Copy and paste the license to activate your software.

An email is also sent to the email address you specified. Keep this email for future 
reference.

6. If the license installation is successful, a license file is created and the Product 
Configuration window reports, “Installation complete.”

License files typically have the following names and locations:

What if I close the Product Configuration window accidentally?
If you close the Product Configuration Wizard accidentally, go to the Windows Start 
menu and select Programs > Autodesk > Autodesk Showcase 2009 > Licensing. 

If you’ve already requested a license from the Internet, select I have a license that I 
need to install from the list of entries and proceed to install your license.
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• For node-locked (single) licenses, C:\FlexLM\aw.dat

• For floating licenses, C:\FlexLM\aw_servername.dat (where servername is 
the name of the license server.

Next steps (if the licensing is successful)
• If you are a node-locked (single machine) user, your software is now activated 

and ready to use. From the Start menu, choose Programs > Autodesk > 
Showcase 2009 > Showcase.

• If you are setting up a floating server and a network of clients, go to the following 
topic:

“Set up a floating license” on page 25

If the licensing is not successful
If the license installation is not successful, a window appears reporting "Installation 
Incomplete."

1. Click the Show Installation Log button to read a log to find out what went wrong. 

2. Go to the “Licensing problems” on page 31 in the Troubleshooting section for more details 
on what to look for. 

Activate the software from a 
license

If you have obtained license data from Autodesk, you can use the Product Configuration 
Wizard to automatically create the license file that is required to use the software.

A license file is created from the license data provided to you by Autodesk. This data may 
have been provided to you in an email, a license file, a fax or even read to you over the 
phone. 

License files typically have the following names and locations:

• For node-locked (single) licenses, C:\FlexLM\aw.dat

Use these instructions if:
• You have already obtained a node-locked license from Autodesk and need to 

install it to activate your software.

Do not use these instructions if:
• You have a serial number but have not yet received a license. Go to the topic, 

“Activate the software from a serial number” on page 19.

• You are setting up a floating license server. See “Set up a floating license” on 
page 25.
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• For floating licenses, C:\FlexLM\aw_servername.dat (where servername is 
the name of the license server.

Activate the software from a license

1. From the Windows Start menu, select Programs > Autodesk > Showcase 2009 > 
Licensing.

The Product Configuration window appears.

2. Select I have a license that I need to install and click Next.

(Click on the + icon beside Licensing Tasks if you don’t see the list of licensing options.)

3. Continue to follow the instructions in the Product Configuration windows to activate your 
software.

What do licenses look like?
Nodelocked licenses look similar to the following sample:

FEATURE AutodeskShowcase sgiawd 3.000 09-jan-2006 uncounted 
7CD390F11000 HOSTID=123456789012

Floating licenses look similar to the following sample:

SERVER pc-server 123456789012 7111 
VENDOR sgiawd 
FEATURE Autodeskshowcasef sgiawd 1.00 10-nov-2006 1\ 
        FC29A6FBF000
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You will need to select the method to install your license (either from a text file on your 
computer, or by pasting or typing from emails or faxes). A message lets you know if the 
data is valid or not.

4. After you enter valid license data or select a valid license file, the Product Configuration 
Wizard reports "Installation Complete" and a license file is created.

License files typically have the following names and locations:

• For node-locked (single) licenses, C:\FLEXLM\AW.DAT

• For floating licenses, C:\FLEXLM\AW_servername.DAT (where servername is 
the name of the license server.

5. Click Done to exit the Product Configuration wizard.You should now be able to run the 
Autodesk Showcase software.

Next steps (if the licensing is successful)
• If you are a node-locked (single machine) user, your software is now activated 

and you can use it. From the Start menu, choose Programs > Autodesk > 
Showcase 2009 > Showcase.

• If you are setting up a floating server and a network of clients, go to the following 
topic:

“Set up a floating license” on page 25

If the licensing is not successful
If the license installation is not successful, a window appears reporting "Installation 
Incomplete."

1. Click the Show Installation Log button to read a log to find out what went wrong. 

2. Go to "Licensing problems" on page 31 in the Troubleshooting section for more details on 
what to look for. 

Set up a floating license

Floating licenses can be used by any networked computer if it has the Autodesk 
Showcase software installed. These computers, known as clients, must have a license file 

Use these instructions if:
• You have a floating license you want to use with one or more networked 

machines.

Do not use these instructions if:
• You have a node-locked (single) license.
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installed that accesses the floating license that is located on one machine, known as the 
license server. Each floating license can be used by only one client machine at a time.

Floating license setup overview

1. Acquire the floating server license.

“Acquire the floating server license” on page 26

2. Set up the license server.

“Install the license server (Windows)” on page 27

“Set up the license server (Windows)” on page 27

“Set up the license server (other platforms)” on page 29

3. Install the software on each client machine. Then copy over to each client an edited 
license file that points to the server.

“Set up the client computers” on page 29

Acquire the floating server license
You may wish to run the software on the server machine, in which case you can install the 
software using Online Product Activation:

“Activate the software from a serial number” on page 19

“Activate the software from a license” on page 23

In some cases, you may want to set up a dedicated license server that does not run the 
software. In this case:

1. Go to the following Web site: www.autodesk.com/opa

2. Fill out the required fields.

For information on serial numbers and hardware IDs, see:

“Introduction” on page 17

3. You will receive a license file by email. 

4. Copy this license file and rename it to:

• For Windows, C:\FlexLM\aw_servername.dat (where servername is the 
name of the license server).

• For UNIX platforms, /var/flexlm/aw_servername.dat (where servername 
is the name of the license server).

If you do not have Internet access ...
If you do not have Internet access, you need to phone in or fax a SPAR form with the 
hardware ID for your server machine. Contact your Autodesk representative for details.
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Install the license server (Windows)

1. If you will be running the software on the server machine, install the complete software:

“Install Autodesk Showcase” on page 11

If you are setting up a dedicated Windows license server that will not run the software, 
choose a custom install and check off all components except for the Licensing Utilities:

“More on custom installation” on page 15

2. License the server using Online Product Activation: 

“Activate the software from a serial number” on page 19

“Activate the software from a license” on page 23

Set up the license server (Windows)

1. You will need to launch the LMTools application (lmtools.exe) to configure and start the 
floating license server.

2. Select Start > Programs > Autodesk > Common Utilities > Flexlm License Utilities.

3. Configure the license server from the LMTools window:

• Click on the first tab, Service/License File. 

• Click Configuration using Services.

• Click on the tab, Config Services. Verify the following settings:

Configuration Services Settings

Path to the lmgrd.exe file C:\Program Files\Common Files\ 
Alias Shared\Licensing\etc\lmgrd.exe

Path to the license file C:\FlexLM\aw_servername.dat  
(where servername is the name of the license server)

Path to the debug log file C:\FlexLM\aw.log

Start Server at Power Up Checked

Use Services Checked 
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Start the License Server from the LMTools window: 

Click on the Start/Stop/Reread tab, then the Start Server button, then the ReRead 
License File button.

There should be a message in the LMTools status bar at the bottom of the window reading 
“Reread successfully” to confirm the license file is being used.

4. Confirm that the server is working from the LMTools window: 

Click on the Server Status tab and click on the button Perform Status Enquiry.

The message in the message area should indicate that the server is working. The 
message will look like the sample below.

-------- 
Status 
-------- 
Flexible License Manager status on Tue 4/23/2005 14:39 
[Detecting lmgrd processes...] 
License server status: 7111@PC-GAIA 
   License file(s) on PC-GAIA: C:\FlexLM\aw.dat: 
   PC-GAIA: license server UP (MASTER) v9.2 
Vendor daemon status (on PC-GAIA): 
    sgiawd: UP v9.2 
Feature usage info: 
Users of AutodeskShowcasef:  (Total of 4 licenses available) 
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Your server licensing process is complete. Proceed to setting up each client computer. 
(See the next section.)

Set up the license server (other platforms)
In some cases, you may want to set up a floating license server on platforms other than 
the Microsoft Windows operating system.

1. Go to www.autodesk.com/licensetools (You may have to register.) 

2. From the Web site, open the installation instructions for the server machine’s operating 
system. From these instructions, find out how to locate the hardware ID for the server 
machine. Copy or write down this hardware ID.

3. Download and install the license tool software on the server machine, if required.

4. Submit your license request at www.autodesk.com/opa/. 

To submit your license request, you need to provide the serial number for the floating 
license you purchased, along with the hardware ID for the machine that will be the floating 
server.

5. Follow the installation instructions from the Web site to set up and configure the server 
and its clients.

Set up the client computers
Client computers must have the Autodesk Showcase software installed and must have a 
client license file that points to the license server. 

To set up the client computer:

1. Install the Autodesk Showcase software on every client computer you are going to set up.

“Install Autodesk Showcase” on page 11

2. On the server machine, make a copy of its server license file, located at:

• For Windows, C:/FLEXLM/aw_servername.dat

• For UNIX, /var/flexlm/aw_servername.dat

Place the copy at another location (for example, your desktop) and rename it 
aw_clientname.dat.

Note Only the original file, aw_servername.dat, should remain in the server’s 
FLEXLM folder.
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3. Edit the file you copied in a text editor (for example, Notepad).

4. Keep the lines beginning with “SERVER” and “VENDOR”.

5. Remove all the rest of the lines in the file.

6. Add a line reading, “USE_SERVER”.

7. Save the aw_clientname.dat file and copy it to the C:\FLEXLM folder on all client 
machines. Rename the file on each client to reflect the client’s machine name (but leave 
the contents of the file the same on all client machines).

8. Make sure the client is on the network and can access the server.

9. Verify that you can launch the software on each client machine by selecting Start > 
Programs > Autodesk > Showcase 2009.

Tip ...
Make sure that Hide known File Extensions is not checked as one of your View 
options for this folder, or the file may be called aw_clientname.dat.txt but you will 
only see it as aw_clientname.dat.

aw_clientname.dat.txt will not work as a license file. (You will have to rename it 
to aw_clientname.dat.)

Example ...
The original file might look like the following:

SERVER PC-GAIA 000000000000 7111 
VENDOR sgiawd 
FEATURE AUTODESKSHOWCASEF SGIAWD 3.000 3-NOV-2005 4 \ 
      000000000000

The edited file should look like the following:

SERVER PC-GAIA 000000000000 7111 
VENDOR sgiawd 
USE_SERVER
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Troubleshooting

Licensing problems
Check the installation log
If the license verification process was not successful, the Product Configuration Wizard 
will report "Installation Incomplete." A good first step is to click the button called Show 
Installation Log to get more details about the failure.

Scan the installation log to attempt to determine the cause of the failure from the log 
details. If you can’t determine the cause of the failure and correct the problem, highlight 
and copy the text into a text file to save the information for future reference. 

(To copy, either right click and select Copy or use the Ctrl + C keys. To paste, either right 
click and select Paste or use the Ctrl+V keys.)

You may not have the right permissions
The Product Configuration Wizard may display a message indicating that you do not have 
permission to save the license file to the folder C:\FLEXLM. It will offer a choice of other 
locations where it can save the license file. It is recommended that you save the license 
file to one of the choices provided.

If you are unable to save to one of the recommended default locations, you can browse to 
a folder where you have write permission and save the file. You will need to copy the file to 
C:\FLEXLM before running Autodesk Showcase; contact your system administrator to 
copy over this file or to change the permissions in this folder.

If you need to launch the Product Configuration Wizard later
If you need to use the Product Configuration Wizard again later, you can launch it by 
choosing Start > Programs > Autodesk > Showcase 2009 > Licensing.
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Contacting the Autodesk 
Showcase support team
Pre-contact checklist
Before you contact the Autodesk Showcase support team for help, take the time to scan 
the following information sources which may help you solve your problem:

• Check the license installation log to see if you can find and solve the licensing 
problem. See “Check the installation log” on page 31.

• Check the release notes and help for any notes that may help troubleshoot your 
problem.

• For information on issues concerning Autodesk Showcase software, go to 
www.autodesk.com/showcase-support.

• For the latest qualification charts, go to www.autodesk.com/qual-charts.

• For information about various Windows issues, see www.microsoft.com

• For information about licensing, see www.macrovision.com

• For details on installation and performance issues concerning graphics cards, 
check the Web site of your graphics card manufacturer 

• Bookstores provide an array of helpful books on Windows for various types of 
users and administrators 

Pre-contact preparations
Before you make a support call, it is helpful to take the following steps to collect 
information that may be required by the support team.

Copy the installation log
If the verification process was not successful, the Product Configuration Wizard will report 
"Installation Incomplete." Click the Show Installation Log button, and highlight and copy 
the log text into a text file to save the log information. 

See “Check the installation log” on page 31.

Get system profile information (for Windows XP)

1. From the Start menu, select Run.

2. In the Run window, type: winmsd

3. Click OK.

4. Select the System Summary category. Then click File > Export.

5. Give the file a name and save it as a text file.

Take screen captures 

1. Press the Print Screen/SysRq key on your keyboard.
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2. Launch Paint (Start > Programs > Accessories > Paint).

3. Choose Edit > Paste.

4. Save the image.

5. Zip the saved image file up (using WinZip® or another program). You may be asked to 
send this file when you make your support call.

Contacting Autodesk Showcase support
For information on how to contact the Autodesk Showcase support team, go to 
www.autodesk.com/showcase-support/.
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GNU Library General Public 
License, Version 2
GNU Library General Public License, Version 2

Copyright (C) 1991 Free Software Foundation, Inc. 675 Mass Ave, Cambridge, MA 02139, USA 

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed. 

[This is the first released version of the library GPL. It is numbered 2 because it goes with version 2 of the ordinary GPL.] 

Preamble 

The licenses for most software are designed to take away your freedom to share and change it. By contrast, the GNU General 
Public Licenses are intended to guarantee your freedom to share and change free software -- to make sure the software is free 
for all its users. 

This license, the Library General Public License, applies to some specially designated Free Software Foundation software, and 
to any other libraries whose authors decide to use it. You can use it for your libraries, too. 

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure 
that you have the freedom to distribute copies of free software (and charge for this service if you wish), that you receive source 
code or can get it if you want it, that you can change the software or use pieces of it in new free programs; and that you know you 
can do these things. 

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to surrender the 
rights. These restrictions translate to certain responsibilities for you if you distribute copies of the library, or if you modify it. 

For example, if you distribute copies of the library, whether gratis or for a fee, you must give the recipients all the rights that we 
gave you. You must make sure that they, too, receive or can get the source code. If you link a program with the library, you must 
provide complete object files to the recipients so that they can relink them with the library, after making changes to the library and 
recompiling it. And you must show them these terms so they know their rights. 

Our method of protecting your rights has two steps: (1) copyright the library, and (2) offer you this license which gives you legal 
permission to copy, distribute and/or modify the library. 

Also, for each distributor's protection, we want to make certain that everyone understands that there is no warranty for this free 
library. If the library is modified by someone else and passed on, we want its recipients to know that what they have is not the 
original version, so that any problems introduced by others will not reflect on the original authors' reputations. 

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that companies distributing 
free software will individually obtain patent licenses, thus in effect transforming the program into proprietary software. To prevent 
this, we have made it clear that any patent must be licensed for everyone's free use or not licensed at all. 

Most GNU software, including some libraries, is covered by the ordinary GNU General Public License, which was designed for 
utility programs. This license, the GNU Library General Public License, applies to certain designated libraries. This license is 
quite different from the ordinary one; be sure to read it in full, and don't assume that anything in it is the same as in the ordinary 
license. 

The reason we have a separate public license for some libraries is that they blur the distinction we usually make between 
modifying or adding to a program and simply using it. Linking a program with a library, without changing the library, is in some 
sense simply using the library, and is analogous to running a utility program or application program. However, in a textual and 
legal sense, the linked executable is a combined work, a derivative of the original library, and the ordinary General Public License 
treats it as such. 

Because of this blurred distinction, using the ordinary General Public License for libraries did not effectively promote software 
sharing, because most developers did not use the libraries. We concluded that weaker conditions might promote sharing better. 

However, unrestricted linking of non-free programs would deprive the users of those programs of all benefit from the free status 
of the libraries themselves. This Library General Public License is intended to permit developers of non-free programs to use free 
libraries, while preserving your freedom as a user of such programs to change the free libraries that are incorporated in them. 
(We have not seen how to achieve this as regards changes in header files, but we have achieved it as regards changes in the 
actual functions of the Library.) The hope is that this will lead to faster development of free libraries. 

The precise terms and conditions for copying, distribution and modification follow. Pay close attention to the difference between a 
"work based on the library" and a "work that uses the library". The former contains code derived from the library, while the latter 
only works together with the library. 

Note that it is possible for a library to be covered by the ordinary General Public License rather than by this special one. 

GNU LIBRARY GENERAL PUBLIC LICENSE 
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION 

0. This License Agreement applies to any software library which contains a notice placed by the copyright holder or other 
authorized party saying it may be distributed under the terms of this Library General Public License (also called "this License"). 
Each licensee is addressed as "you". 

A "library" means a collection of software functions and/or data prepared so as to be conveniently linked with application 
programs (which use some of those functions and data) to form executables. 

The "Library", below, refers to any such software library or work which has been distributed under these terms. A "work based on 
the Library" means either the Library or any derivative work under copyright law: that is to say, a work containing the Library or a 
portion of it, either verbatim or with modifications and/or translated straightforwardly into another language. (Hereinafter, 
translation is included without limitation in the term "modification".) 
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"Source code" for a work means the preferred form of the work for making modifications to it. For a library, complete source code 
means all the source code for all modules it contains, plus any associated interface definition files, plus the scripts used to 
control compilation and installation of the library. 

Activities other than copying, distribution and modification are not covered by this License; they are outside its scope. The act of 
running a program using the Library is not restricted, and output from such a program is covered only if its contents constitute a 
work based on the Library (independent of the use of the Library in a tool for writing it). Whether that is true depends on what the 
Library does and what the program that uses the Library does. 

1. You may copy and distribute verbatim copies of the Library's complete source code as you receive it, in any medium, provided 
that you conspicuously and appropriately publish on each copy an appropriate copyright notice and disclaimer of warranty; keep 
intact all the notices that refer to this License and to the absence of any warranty; and distribute a copy of this License along with 
the Library. 

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection in 
exchange for a fee. 

2. You may modify your copy or copies of the Library or any portion of it, thus forming a work based on the Library, and copy and 
distribute such modifications or work under the terms of Section 1 above, provided that you also meet all of these conditions: 

a) The modified work must itself be a software library. 

b) You must cause the files modified to carry prominent notices stating that you changed the files and the date of any 
change. 

c) You must cause the whole of the work to be licensed at no charge to all third parties under the terms of this License. 

d) If a facility in the modified Library refers to a function or a table of data to be supplied by an application program that 
uses the facility, other than as an argument passed when the facility is invoked, then you must make a good faith effort 
to ensure that, in the event an application does not supply such function or table, the facility still operates, and performs 
whatever part of its purpose remains meaningful. 

(For example, a function in a library to compute square roots has a purpose that is entirely well-defined independent of 
the application. Therefore, Subsection 2d requires that any application-supplied function or table used by this function 
must be optional: if the application does not supply it, the square root function must still compute square roots.) 

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from the Library, 
and can be reasonably considered independent and separate works in themselves, then this License, and its terms, do not apply 
to those sections when you distribute them as separate works. But when you distribute the same sections as part of a whole 
which is a work based on the Library, the distribution of the whole must be on the terms of this License, whose permissions for 
other licensees extend to the entire whole, and thus to each and every part regardless of who wrote it. 

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the intent is to 
exercise the right to control the distribution of derivative or collective works based on the Library. 

In addition, mere aggregation of another work not based on the Library with the Library (or with a work based on the Library) on 
a volume of a storage or distribution medium does not bring the other work under the scope of this License. 

3. You may opt to apply the terms of the ordinary GNU General Public License instead of this License to a given copy of the 
Library. To do this, you must alter all the notices that refer to this License, so that they refer to the ordinary GNU General Public 
License, version 2, instead of to this License. (If a newer version than version 2 of the ordinary GNU General Public License has 
appeared, then you can specify that version instead if you wish.) Do not make any other change in these notices. 

Once this change is made in a given copy, it is irreversible for that copy, so the ordinary GNU General Public License applies to 
all subsequent copies and derivative works made from that copy. 

This option is useful when you wish to copy part of the code of the Library into a program that is not a library. 

4. You may copy and distribute the Library (or a portion or derivative of it, under Section 2) in object code or executable form 
under the terms of Sections 1 and 2 above provided that you accompany it with the complete corresponding machine-readable 
source code, which must be distributed under the terms of Sections 1 and 2 above on a medium customarily used for software 
interchange. 

If distribution of object code is made by offering access to copy from a designated place, then offering equivalent access to copy 
the source code from the same place satisfies the requirement to distribute the source code, even though third parties are not 
compelled to copy the source along with the object code. 

5. A program that contains no derivative of any portion of the Library, but is designed to work with the Library by being compiled 
or linked with it, is called a "work that uses the Library". Such a work, in isolation, is not a derivative work of the Library, and 
therefore falls outside the scope of this License. 

However, linking a "work that uses the Library" with the Library creates an executable that is a derivative of the Library (because 
it contains portions of the Library), rather than a "work that uses the library". The executable is therefore covered by this License. 
Section 6 states terms for distribution of such executables. 

When a "work that uses the Library" uses material from a header file that is part of the Library, the object code for the work may 
be a derivative work of the Library even though the source code is not. Whether this is true is especially significant if the work 
can be linked without the Library, or if the work is itself a library. The threshold for this to be true is not precisely defined by law. 
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If such an object file uses only numerical parameters, data structure layouts and accessors, and small macros and small inline 
functions (ten lines or less in length), then the use of the object file is unrestricted, regardless of whether it is legally a derivative 
work. (Executables containing this object code plus portions of the Library will still fall under Section 6.) 

Otherwise, if the work is a derivative of the Library, you may distribute the object code for the work under the terms of Section 6. 
Any executables containing that work also fall under Section 6, whether or not they are linked directly with the Library itself. 

6. As an exception to the Sections above, you may also compile or link a "work that uses the Library" with the Library to produce 
a work containing portions of the Library, and distribute that work under terms of your choice, provided that the terms permit 
modification of the work for the customer's own use and reverse engineering for debugging such modifications. 

You must give prominent notice with each copy of the work that the Library is used in it and that the Library and its use are 
covered by this License. You must supply a copy of this License. If the work during execution displays copyright notices, you 
must include the copyright notice for the Library among them, as well as a reference directing the user to the copy of this License. 
Also, you must do one of these things: 

a) Accompany the work with the complete corresponding machine-readable source code for the Library including what-
ever changes were used in the work (which must be distributed under Sections 1 and 2 above); and, if the work is an 
executable linked with the Library, with the complete machine-readable "work that uses the Library", as object code 
and/or source code, so that the user can modify the Library and then relink to produce a modified executable containing 
the modified Library. (It is understood that the user who changes the contents of definitions files in the Library will not 
necessarily be able to recompile the application to use the modified definitions.) 

b) Accompany the work with a written offer, valid for at least three years, to give the same user the materials specified 
in Subsection 6a, above, for a charge no more than the cost of performing this distribution. 

c) If distribution of the work is made by offering access to copy from a designated place, offer equivalent access to copy 
the above specified materials from the same place. 

d) Verify that the user has already received a copy of these materials or that you have already sent this user a copy. 

For an executable, the required form of the "work that uses the Library" must include any data and utility programs needed for 
reproducing the executable from it. However, as a special exception, the source code distributed need not include anything that 
is normally distributed (in either source or binary form) with the major components (compiler, kernel, and so on) of the operating 
system on which the executable runs, unless that component itself accompanies the executable. 

It may happen that this requirement contradicts the license restrictions of other proprietary libraries that do not normally 
accompany the operating system. Such a contradiction means you cannot use both them and the Library together in an 
executable that you distribute. 

7. You may place library facilities that are a work based on the Library side-by-side in a single library together with other library 
facilities not covered by this License, and distribute such a combined library, provided that the separate distribution of the work 
based on the Library and of the other library facilities is otherwise permitted, and provided that you do these two things: 

a) Accompany the combined library with a copy of the same work based on the Library, uncombined with any other 
library facilities. This must be distributed under the terms of the Sections above. 

b) Give prominent notice with the combined library of the fact that part of it is a work based on the Library, and explain-
ing where to find the accompanying uncombined form of the same work. 

8. You may not copy, modify, sublicense, link with, or distribute the Library except as expressly provided under this License. Any 
attempt otherwise to copy, modify, sublicense, link with, or distribute the Library is void, and will automatically terminate your 
rights under this License. However, parties who have received copies, or rights, from you under this License will not have their 
licenses terminated so long as such parties remain in full compliance. 

9. You are not required to accept this License, since you have not signed it. However, nothing else grants you permission to 
modify or distribute the Library or its derivative works. These actions are prohibited by law if you do not accept this License. 
Therefore, by modifying or distributing the Library (or any work based on the Library), you indicate your acceptance of this 
License to do so, and all its terms and conditions for copying, distributing or modifying the Library or works based on it. 

10. Each time you redistribute the Library (or any work based on the Library), the recipient automatically receives a license from 
the original licensor to copy, distribute, link with or modify the Library subject to these terms and conditions. You may not impose 
any further restrictions on the recipients' exercise of the rights granted herein. You are not responsible for enforcing compliance 
by third parties to this License. 

11. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to patent 
issues), conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this 
License, they do not excuse you from the conditions of this License. If you cannot distribute so as to satisfy simultaneously your 
obligations under this License and any other pertinent obligations, then as a consequence you may not distribute the Library at 
all. For example, if a patent license would not permit royalty-free redistribution of the Library by all those who receive copies 
directly or indirectly through you, then the only way you could satisfy both it and this License would be to refrain entirely from 
distribution of the Library. 

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the section is 
intended to apply, and the section as a whole is intended to apply in other circumstances. 

It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest validity of any 
such claims; this section has the sole purpose of protecting the integrity of the free software distribution system which is 
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implemented by public license practices. Many people have made generous contributions to the wide range of software 
distributed through that system in reliance on consistent application of that system; it is up to the author/donor to decide if he or 
she is willing to distribute software through any other system and a licensee cannot impose that choice. 

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License. 

12. If the distribution and/or use of the Library is restricted in certain countries either by patents or by copyrighted interfaces, the 
original copyright holder who places the Library under this License may add an explicit geographical distribution limitation 
excluding those countries, so that distribution is permitted only in or among countries not thus excluded. In such case, this 
License incorporates the limitation as if written in the body of this License. 

13. The Free Software Foundation may publish revised and/or new versions of the Library General Public License from time to 
time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or 
concerns. 

Each version is given a distinguishing version number. If the Library specifies a version number of this License which applies to 
it and "any later version", you have the option of following the terms and conditions either of that version or of any later version 
published by the Free Software Foundation. If the Library does not specify a license version number, you may choose any 
version ever published by the Free Software Foundation. 

14. If you wish to incorporate parts of the Library into other free programs whose distribution conditions are incompatible with 
these, write to the author to ask for permission. For software which is copyrighted by the Free Software Foundation, write to the 
Free Software Foundation; we sometimes make exceptions for this. Our decision will be guided by the two goals of preserving 
the free status of all derivatives of our free software and of promoting the sharing and reuse of software generally. 

NO WARRANTY 

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE LIBRARY, TO THE 
EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT 
HOLDERS AND/OR OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER 
EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE 
LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY 
SERVICING, REPAIR OR CORRECTION. 

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT 
HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, 
BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL 
DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF 
DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE 
OF THE LIBRARY TO OPERATE WITH ANY OTHER SOFTWARE), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 

END OF TERMS AND CONDITIONS 

Appendix: How to Apply These Terms to Your New Libraries 

If you develop a new library, and you want it to be of the greatest possible use to the public, we recommend making it free 
software that everyone can redistribute and change. You can do so by permitting redistribution under these terms (or, 
alternatively, under the terms of the ordinary General Public License). 

To apply these terms, attach the following notices to the library. It is safest to attach them to the start of each source file to most 
effectively convey the exclusion of warranty; and each file should have at least the "copyright" line and a pointer to where the full 
notice is found. 

<one line to give the library's name and a brief idea of what it does.>

Copyright (C) <year> <name of author>

This library is free software; you can redistribute it and/or

modify it under the terms of the GNU Library General Public

License as published by the Free Software Foundation; either

version 2 of the License, or (at your option) any later version.

This library is distributed in the hope that it will be useful,

but WITHOUT ANY WARRANTY; without even the implied warranty of

MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU

Library General Public License for more details.

You should have received a copy of the GNU Library General Public

License along with this library; if not, write to the Free

Software Foundation, Inc., 675 Mass Ave, Cambridge, MA 02139, USA.
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Also add information on how to contact you by electronic and paper mail. 

You should also get your employer (if you work as a programmer) or your school, if any, to sign a "copyright disclaimer" for the 
library, if necessary. Here is a sample; alter the names: 

Yoyodyne, Inc., hereby disclaims all copyright interest in the

library `Frob' (a library for tweaking knobs) written by James Random Hacker.

<signature of Ty Coon>, 1 April 1990

Ty Coon, President of Vice

That's all there is to it!
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wxWindows Library License, 
Version 3
wxWindows Library License, Version 3

Copyright (c) 1992-2004 Julian Smart, Robert Roebling, Vadim Zeitlin et al. 

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed. 

WXWINDOWS LIBRARY LICENSE 
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION 

This library is free software; you can redistribute it and/or modify it under the terms of the GNU Library General Public License as 
published by the Free Software Foundation; either version 2 of the License, or (at your option) any later version. 

This library is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the implied warranty of 
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Library General Public License for more 
details. 

You should have received a copy of the GNU Library General Public License along with this software, usually in a file named 
COPYING.LIB. If not, write to the Free Software Foundation, Inc., 59 Temple Place, Suite 330, Boston, MA~02111-1307 USA. 

EXCEPTION NOTICE 

1. As a special exception, the copyright holders of this library give permission for additional uses of the text contained in this 
release of the library as licensed under the wxWindows Library License, applying either version 3 of the License, or (at your 
option) any later version of the License as published by the copyright holders of version 3 of the License document. 

2. The exception is that you may create binary object code versions of any works using this library or based on this library, and 
use, copy, modify, link and distribute such binary object code files unrestricted under terms of your choice. 

3. If you copy code from files distributed under the terms of the GNU General Public License or the GNU Library General Public 
License into a copy of this library, as this license permits, the exception does not apply to the code that you add in this way. To 
avoid misleading anyone as to the status of such modified files, you must delete this exception notice from such code and/or 
adjust the licensing conditions notice accordingly. 

4. If you write modifications of your own for this library, it is your choice whether to permit this exception to apply to your 
modifications. If you do not wish that, you must delete the exception notice from such code and/or adjust the licensing conditions 
notice accordingly. 
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The Python Imaging Library (PIL)
Copyright © 1997-2005 by Secret Labs AB

Copyright © 1995-2005 by Fredrik Lundh

By obtaining, using, and/or copying this software and/or its associated documentation, you agree that you have read, 
understood, and will comply with the following terms and conditions:

Permission to use, copy, modify, and distribute this software and its associated documentation for any purpose and without fee is 
hereby granted, provided that the above copyright notice appears in all copies, and that both that copyright notice and this 
permission notice appear in supporting documentation, and that the name of Secret Labs AB or the author not be used in 
advertising or publicity pertaining to distribution of the software without specific, written prior permission.

SECRET LABS AB AND THE AUTHOR DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING 
ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL SECRET LABS AB OR THE 
AUTHOR BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER 
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR 
OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS 
SOFTWARE. 
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The OpenEXR Library v.1.2.2
Copyright © 2004 by Industrial Light & Magic, a division of Lucasfilm Entertainment Company Ltd.

By obtaining, using, and/or copying this software and/or its associated documentation, you agree that you have read, 
understood, and will comply with the following terms and conditions: 

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in 
the documentation and/or other materials provided with the distribution. 

* Neither the name of Industrial Light & Magic nor the names of any other contributors to this software may be used to endorse or 
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF 
USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY 
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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